_News Letter

NRG Survey System for Winmd ows

Wersion 7

Well another year has passed here at
the office and another version of the
NRG Survey System for Windows is
being released. Version 7 will be
available from September 2003
onwards. We feel that the User will
notice a remarkable improvement in
this version. Anyone who was kind
enough to join us at our yearly User

In order to move toolbar to a new
location, grab the area highlighted
below and drag and drop to the
required place.
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Note that the toolbars can be located
on the top or the left side of the Editor

Window.
Group Conference on the 11" Toolbars are available for the
September will already of had a taste following :-
of what is now available. They will
also have had most of the new features Edit Points Mode
explained to them. For the rest of you, Edit Lines Mode
this News Letter will highlight these Edit Triangles Mode
features and give you a quick Edit Text Mode
explanation to get you started. Edit Boreholes
. Edit Shading
DTM Mapping Model Functions
Addition of Customisable Toolbars Tools
Stations
Incorporated into DTM Mapping is a Mode
user customisable toolbar interface. Loaded Models
This allows the User to turn on or off Show List
s | Sclected toolbars Bore Hole Materials
e and position them Zoom and Pan Controls
T anywhere on the String
o screen to suit their File
*,},‘:;I:m ' personal Raster Image
il preferences. To Cogo / Calc Functions
i access the Toolbar
igﬂﬁ“m“' Setup Menu, press For further information please see page
,“.;“g: F2 or select View 11 of the DTM Mapping Manual.
ek - Toolbars. Tick
Cios | on the appropriate

function bar.

Practical Solutions to Technical Problems

Page 1/12

29 October 2003



Background Model

In response to a lot of users requests,
our background model has been
improved. This function allows the
user to overlay an existing .gpf file as a
coordinated background, without
loading any information into the Editor
Table. Select the file to be viewed
from the Background model Toolbar.
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Select Load from the File Menu. Select
Background Model or turn on the
Background Model Toolbar and press
the folder icon. Choose the file to
view.

Line colours can be set by selecting
Display = Colours.

Point colours and styles in Display =
Line and Point Styles.

Note a number of functions have also
been added to the Setting Out Bar to
allow Dips and Easting, Northing
differences to the background file to be
calculated.

Raster Image

This gives you the ability to display a
bitmap image as a background. Select
Load from the File Menu or use the
Raster Image Toolbar. Select the file to
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load and you will be prompted to
justify the image. Select two points on
the image and give them a coordinate.
You can do this either by manually
typing in the coordinate or by clicking
to a point in the Editor Window. Press
the Scale and Rotate button and press
OK. The image will be loaded into the
background of the Editor Window.

Swap Northing for Level

In order to correctly process Building
Elevations, the ability to swap the
Northing for the Level has been
incorporated. Select, Survey = Swap
Northing for Level. The Editor Table
will then automatically change the
Level for the Northing. Pressing
Redraw will produce an elevation.

Live Cross Sections

To view a live cross section, select
Model = View Section or press the
= button. Click on the start point and
drag a line over the area to be viewed.
Click again for the end of the line. A
Dipped Model and the Background
Model can also be viewed along with
the Editor Section. Vertical
exaggeration can be specified.
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Note the Coordinates for the Start and
End of the section line are shown,
along with the colours currently
assigned to each element. The position
of the cursor can also be displayed.
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3D Render View and Drive Through

One of our biggest advancements over
the past year has been the addition of
the Render Engine; a fully Direct X8.0
compatible 3D model viewer at an
introductory price of £199. Any
existing .gpf file with a triangle model
can be used in conjunction with the
Render Engine. A maximum of 255
files can be loaded simultaneously.

With a triangulated model open in
DTM Mapping, click the Render
Button 2/ in the main toolbar. This will
start the Render Window.
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In order to view more than one model
in the Render Window each individual
file must be triangulated. Press the
Configuration button. You can add up
to 255 models by pressing the Add
button and selecting the file.

Each file can have its Render
properties edited individually by
highlighting the file and changing its
setting in the Configuration Window.
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Note that the Volume Surface Layers
in the loaded file contain the
information for colours or digital
textures.
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To create a Drive Through

Select the appropriate String from the
drop down list, select the Start and End
Chainages. You
must specify

Drive Through .
T I A

> 2]
how often the
engine will sting [woon =
render the drive
ainage Start 200
through. Note Chainage End o
that’ the Smaller Chainage Interval |-|_5

the Setting the
Height &bove Ground |2—

slower the

movie. Tell the Tenain Hugging W [~ Bomb Bay Wiew
System the Offzet From String |-2.5

Offset from o Offset Left € DOffset Right
String Left or

Right if required.

A height above ground should be
specified; if set to 0 the drive through
will follow the ground levels.

Toggle on or off the options for
Terrain Hugging and Bomb Bay views.

Drive Through
ievs Direction

> b [T wm | | & | 4 [fewDiecin
Chainage: 270.500 @

Press the Play button when happy with
all the settings.

Note that, if the Chainages are reversed
the Drive Through runs in the opposite
direction to the String.

As the Drive Through starts a Control
Bar appears to allow you to stop, start
the movie and control the View
Direction.

The Boot button allows you to stop the
Drive Through, get out of the car and
walk about. Use the arrow keys to
control movement when on foot.
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Model Morpher

Model Morpher allows you to apply
Deformation or Lift to a selected Zone
of Influence.
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Draw Limit of
Influence — Will
allow you to draw
a Lasso Line
around the points,
which will act as
i the extents of any
Deformation.
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Maximum Adjustment — Specify the
maximum Deformation or Lift amount

The Current Adjustment is displayed.

Volumes are displayed either based on
a previous Volume Measurement or
against a Datum Level. As the Area of
Influence has Deformation or Lift
applied the Volume will update.
Therefore allowing you to Custom
Design an area to store a given Volume
of Material.
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Show List

The Show List Toolbar offers an
alternative to the right click menu and
allows the user to turn on or off the
elements of the Display. The added
advantage over the right click menu is
the ability to turn multiple layers on or
off at the same time.

J_ll ¥ Text i

Tenxt
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Line Features

Break Lines

Contours

Contourable Triangles
Moncontourable Tranal...
Shading

Grid

Control Stations

String

Column Text...

Foints

Surfaces

Wire Frame (30
Surface Boundaries
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B ackground Model
Pointz out of Tolerance
Selected Background
R aster Images

Sting Graphics
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Tunnelling

A number of Tunnelling options have
been included in the Setting Out side
bar. These are :-

Tunnel X Offset Difference
Tunnel Y Offset Difference
Tunnel Radial Offset Difference
Alignment Offset
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Align Points

In order to make the surveying of
features such as steps easier, we have
incorporated a function which will
Align Points to a specified line. Select
Align Points from the Calc Menu or
press the “I button. Select the two
points to act as the alignment. You can
then click on any other points to shift
them to the line.

Centre of Best Fit Circle

Select the points around the Circle in
the usual way and select Centre of Best
Fit Circle by pressing the 2! button.
The system will calculate the centre of
the circle, and add a point for you and
prompt you for a level.

Chainage Markers

At long last after many requests, a
Chainage Marker System has been
implemented. Select the appropriate
String from the drop down list and
select Display = String Setup, then

press Graphics Settings.
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Tell the system the Start, Interval and
End Chainage. Specify the Offset for

Specific Levels
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Selected points
can be shifted
to a specific
level, a null
level or to

levels from a second file. Select the
points and choose Edit = shift points.

Long Triangles

Triangulation Options

[~ Check for duplicate points

¥ Apply breaklines
v Apply boundaries

[~ ¥iew triangulation

[¥ Restrict Triangle Length::

e
o |

Cancel |

On
triangulating
for the first
time, you will
notice a new
feature to stop
triangles
forming over a
specified

length. Turn the option on and enter
the maximum allowed Triangle

Length.

Import General Coordinates

Found under the File Import Dialogue;

the Import
General
Coordinates
allows DTM
Mapping to
read a file of
any given
format.
Simply

select the appropriate fields, their order
and any value separator like a comma.

text and section tick marks.
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Add Curve

It is now possible to Add a Curve
through either 4 points, or two points

with an intersection.

P Select Calc - Add
Curve.

= rme v ww | Pictorially, select

™ Jpoats T M

Speiatioy the points and enter

W i Aok T8 the Curve

Lavuis

S - s aerl|  Information. Note
[ tesmpnensnset BEH - that g new Line
cemeesl 2| Style can be run
[ ] mser | o | through the
generated points. Press Add to import

the Curve Data into the Editor.

DXF Output

Although offering the same expected
functionality, the user interface for our
DXF output is noticeably different.
Line styles and Points Features are
now fully supported. Two options are
available; a DXF Output containing all
the Editor Information, or a Triangle
Export to export the triangle model as
a renderable DXF.
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The system then prompts for the parts
of the model to be exported. The
exported model can contain every
element of the DTM Mapping Display.
However this may not always be
necessary, so each individual element
can be toggled on or off independently.
If Contours are to be exported, you
should specify the intervals and limits
to be used, as well as any smoothing
that is to be applied. You also need to

tell the system how often to place
points along the contours themselves.

A 2D DXF will contain all the Line
and Point Features drawn correctly, but
will have no levels attached.

A 3D DXF with overlay will create a
3D DXF model (with levels) and a 2D
model for the lines and features (with
no levels).

You may choose to Output Continuous
Line Styles or Line Styles with 2D
Block Overlay. A Continuous Line
will not show any features. Line Styles
with 2D Block Overlay will Output the
DTM Mapping Features as a 2D
Overlay. The system prompts for the
name of the Export File. Enter the
required name and press OK.

Choose a Scale for your output file if
you are using By Layer Line Widths.
This information is then used to scale
the line features in AutoCad.

Tilt Points

To tilt points about a Central Origin
select the points and choose Edit >
Tilt Points. Enter the coordinate which
tilt will be applied and enter the slope
parameters.
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Wild Cards for Feature Codes

New Features Files are being
dispatched with this Software Release.
We would like to encourage the User
to adopt these files as a number of
changes have been made. Most
noticeably the addition of Wild Card
Features, i.e. a lines style B??? means
the system recognises any code that
starts with a B. Load the new features
file and you will see the Wild Card
Features.

Add Points by Polars

Points can be added from a Bearing
and a Distance in DTM Mapping. To
access this

)
e function press
o e the ¥ button on

the Calc
Toolbar. Select

ES60 863 WI9934M

Dlsiaeos | 245 the point from
ok e which the
New paink bearings will be
ER9EM  N967.24 calculated by

clicking in the
display window.
Enter your
Bearing and Distance and a new
coordinate will be calculated and
added.
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GSI Files

For those of you with a Leica
instrument; an export to Leica GSI File
g ot towncmrie

Gelect Mk Gotlngs:

Routine has
been included.
Open the correct
file for
conversion and
select File >
Export = Leica
] weel| GSI. You will
be prompted to select the elements of

Wjﬁﬂ'

the file you wish to export. Also
improvements have been made to the
import routines

Moss Extractor

Although Moss Extractor already had
Setting Out functions for Batter Rails
and Profiles, the User interface has

been massively revised for version 7.

Export Batter Rails

Press the Batter Rail Calculation
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Select the String which is closest to the
point you wish to Offset in the Offset
from Window. Specify the required
offset.

Pick the strings to project the grade
between Plane From and Plane To.

Specify the Traveller Heights and
Chainage range for the calculations.
Note that separate Travellers can be
specified for Cut and for Fill.

The following output formats can be
selected for the produced file : Print
List, .gpf file, General Export or Dump
to a data logger.
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Note that, strings can be selected
pictorially. Ensure that you are in the
correct box and simply click the cursor
over the line required.

Export Profiles

Press the Profile Calculation Button
Select the String that is closest to the
offset point in offset from and specify
the required offset.

Pick the strings to project the grade
between Plane From and Plane To.
Note that to successfully calculate
Profiles for a Crown you will need to
run the calculations twice; once for
each Grade.
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Specify the Traveller Heights and
Chainage Range for the calculations.

You may select from Print List, .gpf
file, General Export or Dump to a Data
Logger for the output format of the
produced file.

Practical Solutions to Technical Problems
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Design

Track Design Interface

To make life easier for those who build
railways, we have introduced a Track
Design Interface. Open Design press
to enter Track Design.

The system needs to know from where
the cants should be interpreted.
Options are Left Rail, Right Rail,
Centre or Low Rail. Note that, if the
Low Rail option is used the cant
interpolation will be taken from the
Lowest Rail, which may vary from
side to side. Simply Toggle the
appropriate Setting on.
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A width between the rails must be
specified which will be used for all
calculations.

The need to have the cants in the Left
and Right road have been done away
with, now the entire cant is specified as
one fall.

Horizontal and Vertical Alignments
are entered as before.

Press the button to return to the
Road design module.
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Cross Sections
Export Setting Out

Within the Cross Sections Module is
the ability to export Setting Out
information for many purposes.

Open Cross Sections.

Select Sections from the top drop
down menu and click Export Setting
Out, the following screen will greet
you: -

Export Setting Out By x|

Lager: [Moss 18/07/01 |

rLeft:  Right

Ottset from: [coon =] b [ ]| | oftset tromi gy =] befi |
Plane: Plane:

from: [copp =] te [com ] from:[ copo =] e [com =]

r~ Traveller for -ve slopes (fill)

Traveller height: 1|

" Perpendicular  (* Vertical traveller

(s
@ Al
" Range
Start Chainage
Itervat:
End Chainage
Add Chainage

r~ Traveller for +ve slopes (cut)

Traveller height: ||

€ Perpendicular & Vertical ~ traveller

~Sort C Sort
€ Ascending € Ascending
" Descending | | (" Descending
& None @ Walk pattern

- Output to:

| Print List ¥ Ezport

[ Create Layer [~ Dump

Remoye Chainage

[#Label paints with Chainage
and siope distance

Select the Layer that holds all the
Design Information from the Layer
control drop down menu in the top left
of the window. The Left offset is the
string from which the left hand side
offset will be calculated, (LOC), the
right, (the ROC). Specify any required
Offsets from edge of carriageway in
Offset By.

To project grades from the sectional
information we must use the Plane
"From" and "To" drop down dialogue
for each side independently. Select the
string closest to the offset line as your
Plane From, and the string dictating the
breaking point of the fall as your Plane
To. (This may be the opposite edge in
a co-planar situation, or could be the
central string in a balanced crowned
carriageway.) Repeat the exercise for
the opposite side.

Any required Travellers can

to the calculations at this stage.
Specifying the Traveller Height and
whether the Traveller is measured
Perpendicularly or Vertically. Note
that, two options are available, one for
Fill slopes (those of a negative grade)
and Cut Slopes (those of a positive
grade). This option becomes necessary
when calculating Batter Rails. As Cut
and Fill rails usually have a different
Traveller. However for Profiles they
will both need to be the same.

Select the chainages either by All in
the Section file or by specifying a
range. The Output To allows you to
choose what format to output the
calculations in. The options being to
print a list to the default windows
printer, Export to an NRG .gpf file,
create the points into a new layer,
dump directly to an external data-
logging device.

Global
Change Project

The change project dialogue has been
revised to include the option to sort all
listed projects by the date they were
created, or alphabetically. We have
also included the option to search for a
project name.
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New Feature in Workabout to report The New CD
Slews and lifts for railway

maintenance. Our CD has changed. Don’t be scared

of the new look of the CD, we have
The alignment can be entered on the changed the front end and improved
workabout or downloaded through the robustness of the installation
NRG Design module on a PC. program.
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Horizontal & Vertical tangent points
are stored as well as a list of cants
where they change.

A setting is available to use a cubic or
linear interpolation between cants.

The user sets his OccStn details as

normal, opens the relevant string if not
already open, and sets the display .
mode to Rail Slews. L e

F File [ Display | OccStn_Set  Utils | Select Install NRG to install the
Display Mode : Rail Slews & Lifts 2=|[ programs to your Hard Drive.

J . .
',;'S;g,‘i EE 7 Remember that installing the latest

Coordinates =C|J version will not destroy any of your

IF':II::E % existing data.

Also included on the CD are a number
of sample jobs. Information for these
can be found on the installation screen.

The gauge can be set in the main
settings screen or from the display
screen itself.

chail Settings | Display Quit ) Technical Support Line
o+ (TS | Lever 1ca’ Support 21
Slew | H.858 | We have recently had a dedicated
Lift | . 764 | Support Line installed, in the hope that
we can deal more efficiently with any

technical queries.
When a point is surveyed or hand
entered the lifts and slews are reported The number for this Support Line is
thus;
09065 221109

Chainage String: MB17
Offset Level Note all Support Calls are charged at £1.50 a
minute.
Slew | H . HEH |
Lift | B.764 | Or send us an email at :-

support@nregsurveys.co.uk
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What do vou have to say

We would like to hear your comments
over the technical support line and the
conference / user group. Please tell us
what you think and give us any
comment on how we can improve the
service.

The Snowdon Experience

As those of you who joined us at the
User group / Conference were aware,
an intrepid bunch of us walked to the
summit of Snowdon. Thanks to all
those involved and here’s a picture of
the wind swept wanderers at the top of
North Wales.

W‘ﬁlﬂ

The Conference / User Group

Held on the 11" and 12" of September
our yearly conference has past.
Hopefully everybody that came along
had an enjoyable couple of days and
most importantly benefited for the
whole experience, leaving having
learnt something new. We are
currently sending out a questionnaire
to all those involved in the conference
to improve the service for next year.
Please ask if you would like a
questionnaire and have not received
one.

Laminated Code Lists

We have a number of laminated field
code lists containing all the default
DTM Mapping Feature Codes. The
ideal solution for those who forget
their codes, or have a number of
surveyors all using different coding
systems. Please inform us if you
require one.
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Render Engine

Software for 3D Visualizations and Drive Throughs

Create eye catching 3D
Visualizations with ease.

Use any existing Files.

Load Multiple Models.
Adjust Lighting and
Transparency.

Rotate using 3D Orbit
Vertical Exaggeration
adjustment.

View Underside of Models
Import Scanner Point Clouds,
AutoCad Dxfs and 3D Studio
Max Raw files.

Overlay Designs
and Ogls.
Highlight
potential design
errors.

Visualize your
job.
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Save View as image files.

Set individually Colours and Transparencies for
each Model.

Even use digital textures based on the triangle
surface layers.

The only limit is your imagination.

Drive throughs created along existing Dhimas 5l [z

strings at specified chainages and offsets.

User defined Eye Height.

Terrain Hugging and Bomb Bay Views.

User Controlled View Direction.

Even walk about the Model at will.
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